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[Title of Course] Syllabus	Comment by ODEE Distance Education: To Instructor regarding use of template: This template, which has been designed for digital accessibility, provides customizable instructor expectations for online and hybrid classes. See the ODEE syllabus template article (go.osu.edu/online-syllabus) for further context and recommendations, included additional example items to customize.
	Comment by ODEE Distance Education: To Instructor regarding accessibility: Before sharing this document with students, the instructor will need to do the following:

 Select File > Properties > Summary > Title to replace “[Title of Course]” and “[Term]” with the actual title and term of the course. 
 Double click to update the footer text box with the correct College and Department for your course
 Right click the footer text box and select “Edit Alt Text” to update the alt text with the same College and Department information. 
Throughout the template remove all brackets and instructional text and replace with course-specific information. To do this quickly you can use Edit > Find to search for “[”
 Delete any non-applicable items.
 Select Review > Check Accessibility and resolve any accessibility errors.
 Rename the file “[CourseAbbrev]-[Term]-syllabus.doc” (or follow whatever convention your unit uses).

Please also be aware that the styling and heading structure of this document are accessibility features and editing the styling and structure could render the document inaccessible.
[ABC1234] [Spring 2020]
Course Information
· Course times and location: [example: “Tuesdays and Thursdays, 10:20 a.m.-11:15 a.m. in Zoom” or “Wednesdays, 9:35 a.m.-10:55 a.m. plus weekly Carmen interaction” or “No required schedule meetings; all instruction occurs in Carmen each week”]
· Credit hours: [example: 3]
· Mode of delivery: Distance Learning	Comment by ODEE Distance Education: To Instructor: Use the label from the schedule of classes: If there are required in-person components, use “Distance Enhanced” (classes that are 75% or more online) or “Hybrid” (classes where students participate online 25-75% of the time). See the Registrar's job aid on class labels.
Instructor
· Name: [First and last name of instructor]
· Email: [lastname.#@osu.edu]
· Office location: [example: 1001D University Hall]
· Office hours: [example: Tuesdays and Thursdays from 10:20 a.m.-11:15 a.m.]
· Preferred means of communication:
· My preferred method of communication for questions is email.
· My class-wide communications will be sent through the Announcements tool in CarmenCanvas. Please check your notification preferences (go.osu.edu/canvas-notifications) to be sure you receive these messages.
Teaching Assistant
· Name: [first and last name of TA]
· Email: [lastname.#@osu.edu]
· Recitation times: [example: Tuesdays and Thursdays from 10:20 a.m.-11:15 a.m.]
Course Prerequisites
[Place course prerequisites here.]
Course Description
[Place course description here.]
Learning Outcomes
By the end of this course, students should successfully be able to:
[List all learning outcomes.]
[Learning outcome]
[Learning outcome]
General Education Expected Learning Outcomes
As part of the [GE Category Name] category of the General Education curriculum, this course is designed to prepare students to be able to do the following:
[List all learning outcomes.]
[Learning outcome]
[Learning outcome]
This course fulfills these learning outcomes by [place a statement about how the course fulfills the listed GE learning outcomes here.]
How This Online Course Works	Comment by ODEE Distance Education: To Instructor: Customize this section with information about your particular course context. 

These expectations can vary widely between courses, depending on whether the participation is synchronous (live) or asynchronous (CarmenCanvas only), so your guidance in the syllabus can be crucial.
Mode of delivery: This course is 100% online. There are no required sessions when you must be logged in to Carmen at a scheduled time.

[Or: This course is 100% online. There is a required synchronous (real-time) session in Zoom each week on Wednesdays from 10-11:50 a.m. The rest of your work is found in Carmen and can be completed around your own scheduled during the week

Or: This course is hybrid. We have required sessions each week on Wednesdays from 10-11:50 a.m. in CL150. The remainder of your work will take place in Carmen throughout the week.]

Pace of online activities: This course is divided into weekly modules that are released one week ahead of time. Students are expected to keep pace with weekly deadlines but may schedule their efforts freely within that time frame.

Credit hours and work expectations: This is a [3] credit-hour course. According to Ohio State bylaws on instruction (go.osu.edu/credithours), students should expect around [3] hours per week of time spent on direct instruction (instructor content and Carmen activities, for example) in addition to [6] hours of homework (reading and assignment preparation, for example) to receive a grade of [C] average.

Attendance and participation requirements: Research shows regular participation is one of the highest predictors of success. With that in mind, I have the following expectations for everyone’s participation:	Comment by ODEE Distance Education: To Instructor: Customize this section with your own attendance policy.

If the class has regular required Zoom meetings, indicate your attendance policy for those meetings first.

For Distanced Enhanced or Hybrid classes, include a bullet point about attendance expectations for in-person meetings.

Participating in online activities for attendance: at least once per week
You are expected to log in to the course in Carmen every week. During most weeks you will probably log in many times. If you have a situation that might cause you to miss an entire week of class, discuss it with me as soon as possible. 
Zoom meetings and office hours: optional
All live, scheduled events for the course, including my office hours, are optional. I will post recordings of synchronous sessions for those who cannot attend.
Participating in discussion forums: two or more times per week
As part of your participation, each week you can expect to post at least twice as part of our substantive class discussion on the week's topics.
Course Materials, Fees and Technologies
Required Materials and/or Technologies	Comment by ODEE Distance Education: To Instructor: List any free or low-cost ways to access the required materials, including library e-books or print reserves, acceptable used editions, or open-access resources.
[Required material or technology]
[Required material or technology]
[Required material or technology]
Recommended/Optional Materials and/or Technologies
[Recommended material or technology]
[Recommended material or technology]
[Recommended material or technology]
Fees and/or Additional Requirements	Comment by ODEE Distance Education: To Instructor: List any fees, out-of-class attendance requirements, etc., including proctoring. Delete if not applicable.
[Fee and/or requirement]
[Fee and/or requirement]
[Fee and/or requirement] 
Required Equipment
Computer: current Mac (MacOS) or PC (Windows 10) with high-speed internet connection
Webcam: built-in or external webcam, fully installed and tested
Microphone: built-in laptop or tablet mic or external microphone
Other: a mobile device (smartphone or tablet) to use for BuckeyePass authentication
If you do not have access to the technology you need to succeed in this class, review options for technology and internet access at go.osu.edu/student-tech-access.
Required Software
Microsoft Office 365: All Ohio State students are now eligible for free Microsoft Office 365. Visit the installing Office 365 (go.osu.edu/office365help) help article for full instructions.
CarmenCanvas Access
You will need to use BuckeyePass (buckeyepass.osu.edu) multi-factor authentication to access your courses in Carmen. To ensure that you are able to connect to Carmen at all times, it is recommended that you do each of the following:
Register multiple devices in case something happens to your primary device. Visit the BuckeyePass - Adding a Device (go.osu.edu/add-device) help article for step-by-step instructions. 
Request passcodes to keep as a backup authentication option. When you see the Duo login screen on your computer, click Enter a Passcode and then click the Text me new codes button that appears. This will text you ten passcodes good for 365 days that can each be used once.
Install the Duo Mobile application (go.osu.edu/install-duo) on all of your registered devices for the ability to generate one-time codes in the event that you lose cell, data, or Wi-Fi service.
If none of these options will meet the needs of your situation, you can contact the IT Service Desk at 614-688-4357 (HELP) and IT support staff will work out a solution with you.
Technology Skills Needed for This Course
Basic computer and web-browsing skills
Navigating CarmenCanvas (go.osu.edu/canvasstudent)
CarmenZoom virtual meetings (go.osu.edu/zoom-meetings)
Recording a slide presentation with audio narration and recording, editing and uploading video (go.osu.edu/video-assignment-guide)
Technology Support
For help with your password, university email, CarmenCanvas, or any other technology issues, questions or requests, contact the IT Service Desk, which offers 24-hour support, seven days a week.

· Self Service and Chat: go.osu.edu/it
· Phone: 614-688-4357 (HELP) 
· Email: servicedesk@osu.edu
Grading and Faculty Response
How Your Grade is Calculated 
	Assignment Category
	Points

	
	

	
	

	
	

	
	

	
	

	
	

	
	

	
	



See Course Schedule for due dates.
[bookmark: _Descriptions_of_Major]Descriptions of Major Course Assignments
[Assignment name or category, Example: Written Assignments]	Comment by ODEE Distance Education: To Instructor: The text in this section is provided as a suggestion. Fill in with your own policies. 

Copy and paste this placeholder text to add additional categories for all your major assignment types. 

Academic integrity guidelines specific to each type will help students translate their in-person expectations to this online format. View sample syllabus language (go.osu.edu/odee-syllabus-integrity).
Description: [Place description here.]

Academic integrity and collaboration: [Example: Your written assignments, including discussion posts, should be your own original work. In formal assignments, you should follow [MLA/APA/Chicago etc.] style to cite the ideas and words of your research sources. You are encouraged to ask a trusted person to proofread your assignments before you turn them in but no one else should revise or rewrite your work.]
Late Assignments	Comment by ODEE Distance Education: To Instructor: The text in this section is provided as a suggestion. Fill in with your own policies. 

Please refer to Carmen for due dates. Due dates are set to help you stay on pace and to allow timely feedback that will help you complete subsequent assignments.
[Example: Due to the collaborative nature of class discussions, I am not able to grade posts submitted after the final weekly deadline for this assignment type.]	Comment by ODEE Distance Education: To Instructor: Explain any specific late work policies. Context about why you have implemented these policies can help reduce student questions.
Instructor Feedback and Response Time	Comment by ODEE Distance Education: To instructor: The text in this section is provided as a suggestion. Fill in with your own policies.
[Example: I am providing the following list to give you an idea of my intended availability throughout the course. Remember that you can call 614-688-4357 (HELP) at any time if you have a technical problem.

Preferred contact method: If you have a question, please contact me first through my Ohio State email address. I will reply to emails within 24 hours on days when class is in session at the university.
Class announcements: I will send all important class-wide messages through the Announcements tool in CarmenCanvas. Please check your notification preferences (go.osu.edu/canvas-notifications) to ensure you receive these messages.
Discussion board: I will check and reply to messages in the discussion boards once mid-week and once at the end of the week.
Grading and feedback: For assignments submitted before the due date, I will try to provide feedback and grades within seven days. Assignments submitted after the due date may have reduced feedback, and grades may take longer to be posted.]
Grading Scale
93–100: A 
90–92.9: A- 
87–89.9: B+
83–86.9: B
80–82.9: B- 
77–79.9: C+ 
73–76.9: C
70–72.9: C- 
67–69.9: D+ 
60–66.9: D
Below 60: E
Other Course Policies	Comment by ODEE Distance Education: To Instructor: Consider whether you need to add context specific sections for health and wellness related to current events, your discipline, student population, or subject material. For example: COVID-19 disruption guidance.
Discussion and Communication Guidelines	Comment by ODEE Distance Education: To Instructor: The text in this section is provided as a suggestion. Fill in with your own policies. 

These expectations are appropriate for classes where discussion occurs in CarmenCanvas. 

Suggested language for Zoom-based classes can be found under discussion expectations (go.osu.edu/odee-syllabus-discussion) in the ODEE syllabus template article.
[Example: The following are my expectations for how we should communicate as a class. Above all, please remember to be respectful and thoughtful.

Writing style: While there is no need to participate in class discussions as if you were writing a research paper, you should remember to write using good grammar, spelling, and punctuation. A more conversational tone is fine for non-academic topics.
Tone and civility: Let's maintain a supportive learning community where everyone feels safe and where people can disagree amicably. Remember that sarcasm doesn't always come across online. I will provide specific guidance for discussions on controversial or personal topics.
Citing your sources: When we have academic discussions, please cite your sources to back up what you say. For the textbook or other course materials, list at least the title and page numbers. For online sources, include a link.
Backing up your work: Consider composing your academic posts in a word processor, where you can save your work, and then copying into the Carmen discussion.
Synchronous sessions: During our Zoom sessions I ask you to use your real name and a clear photo of your face in your Carmen profile. During our full-group lecture time, you may turn your camera off if you choose. When in breakout rooms or toher small-group discussions, having cameras and mics on as often as possible will help you get the most out of activities. You are always welcome to use the free, Ohio State-themed virtual backgrounds (go.osu.edu/zoom-backgrounds). Remember that Zoom and the Zoom chat are our classroom space where respectful interactions are expected.]
Academic Integrity Policy
See Descriptions of Major Course Assignments for specific guidelines about collaboration and academic integrity in the context of this online class.
Ohio State’s Academic Integrity Policy
Academic integrity is essential to maintaining an environment that fosters excellence in teaching, research, and other educational and scholarly activities. Thus, The Ohio State University and the Committee on Academic Misconduct (COAM) expect that all students have read and understand the university’s Code of Student Conduct (studentconduct.osu.edu), and that all students will complete all academic and scholarly assignments with fairness and honesty. Students must recognize that failure to follow the rules and guidelines established in the university’s Code of Student Conduct and this syllabus may constitute “Academic Misconduct.”

The Ohio State University’s Code of Student Conduct (Section 3335-23-04) defines academic misconduct as: “Any activity that tends to compromise the academic integrity of the university or subvert the educational process.” Examples of academic misconduct include (but are not limited to) plagiarism, collusion (unauthorized collaboration), copying the work of another student, and possession of unauthorized materials during an examination. Ignorance of the university’s Code of Student Conduct is never considered an excuse for academic misconduct, so I recommend that you review the Code of Student Conduct and, specifically, the sections dealing with academic misconduct.

If I suspect that a student has committed academic misconduct in this course, I am obligated by university rules to report my suspicions to the Committee on Academic Misconduct. If COAM determines that you have violated the university’s Code of Student Conduct (i.e., committed academic misconduct), the sanctions for the misconduct could include a failing grade in this course and suspension or dismissal from the university.
If you have any questions about the above policy or what constitutes academic misconduct in this course, please contact me.

Other sources of information on academic misconduct (integrity) to which you can refer include:

Committee on Academic Misconduct (go.osu.edu/coam)
Ten Suggestions for Preserving Academic Integrity (go.osu.edu/ten-suggestions)
Eight Cardinal Rules of Academic Integrity (go.osu.edu/cardinal-rules)
Copyright for Instructional Materials
The materials used in connection with this course may be subject to copyright protection and are only for the use of students officially enrolled in the course for the educational purposes associated with the course. Copyright law must be considered before copying, retaining, or disseminating materials outside of the course.
Creating an Environment Free from Harassment, Discrimination, and Sexual Misconduct
The Ohio State University is committed to building and maintaining a community to reflect diversity and to improve opportunities for all. All Buckeyes have the right to be free from harassment, discrimination, and sexual misconduct. Ohio State does not discriminate on the basis of age, ancestry, color, disability, ethnicity, gender, gender identity or expression, genetic information, HIV/AIDS status, military status, national origin, pregnancy (childbirth, false pregnancy, termination of pregnancy, or recovery therefrom), race, religion, sex, sexual orientation, or protected veteran status, or any other bases under the law, in its activities, academic programs, admission, and employment. Members of the university community also have the right to be free from all forms of sexual misconduct: sexual harassment, sexual assault, relationship violence, stalking, and sexual exploitation.

To report harassment, discrimination, sexual misconduct, or retaliation and/or seek confidential and non-confidential resources and supportive measures, contact the Office of Institutional Equity:

Online reporting form at equity.osu.edu,
Call 614-247-5838 or TTY 614-688-8605,
Or email equity@osu.edu

The university is committed to stopping sexual misconduct, preventing its recurrence, eliminating any hostile environment, and remedying its discriminatory effects. All university employees have reporting responsibilities to the Office of Institutional Equity to ensure the university can take appropriate action:

All university employees, except those exempted by legal privilege of confidentiality or expressly identified as a confidential reporter, have an obligation to report incidents of sexual assault immediately.
The following employees have an obligation to report all other forms of sexual misconduct as soon as practicable but at most within five workdays of becoming aware of such information: 1. Any human resource professional (HRP); 2. Anyone who supervises faculty, staff, students, or volunteers; 3. Chair/director; and 4. Faculty member.
Your Mental Health
As a student you may experience a range of issues that can cause barriers to learning, such as strained relationships, increased anxiety, alcohol/drug problems, feeling down, difficulty concentrating and/or lack of motivation. These mental health concerns or stressful events may lead to diminished academic performance or reduce a student's ability to participate in daily activities. No matter where you are engaged in distance learning, The Ohio State University’s Student Life Counseling and Consultation Service (CCS) is here to support you. If you find yourself feeling isolated, anxious or overwhelmed, on-demand mental health resources (go.osu.edu/ccsondemand) are available. You can reach an on-call counselor when CCS is closed at 614- 292-5766. 24-hour emergency help is available through the National Suicide Prevention Lifeline website (suicidepreventionlifeline.org) or by calling 1-800-273-8255(TALK). The Ohio State Wellness app (go.osu.edu/wellnessapp) is also a great resource. 
Accessibility Accommodations for Students with Disabilities
Requesting Accommodations
The university strives to make all learning experiences as accessible as possible. If you anticipate or experience academic barriers based on your disability including mental health, chronic or temporary medical conditions, please let me know immediately so that we can privately discuss options. To establish reasonable accommodations, I may request that you register with Student Life Disability Services (SLDS). After registration, make arrangements with me as soon as possible to discuss your accommodations so that they may be implemented in a timely fashion. In light of the current pandemic, students seeking to request COVID-related accommodations may do so through the university’s request process, managed by Student Life Disability Services.
Disability Services Contact Information
· Phone: 614-292-3307
· Website: slds.osu.edu
· Email: slds@osu.edu
· In person: Baker Hall 098, 113 W. 12th Avenue
Accessibility of Course Technology
This online course requires use of CarmenCanvas (Ohio State's learning management system) and other online communication and multimedia tools. If you need additional services to use these technologies, please request accommodations as early as possible. 
CarmenCanvas accessibility (go.osu.edu/canvas-accessibility)
Streaming audio and video
CarmenZoom accessibility (go.osu.edu/zoom-accessibility)
[bookmark: _Course_schedule]Course Schedule
Refer to the CarmenCanvas course for up-to-date due dates.
	Week
	Points
	Topics, Readings, Assignments, Due Dates
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